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WHERE TO FIND THE WEB PAGE 
 
 
 
 

• www.maricopa.gov/Assessor 

• Click on Maps 
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WHERE TO FIND THE WEB PAGE (Con’t) – 
 

 
 
 
 
CONTACT US  
 

Russ Heisinger 
GIS Manager 
Maricopa County Assessor’s Office 
301 W. Jefferson St., Suite 250 
Phoenix, AZ 85003 
(602) 372-1627 

     
rheisin@mail.maricopa.gov 
 
or 
 
Mapping@ Mail.maricopa.gov 

• Click on GIS INTERACTIVE MAPS 



 

Train_Handout_07.doc              5            

WEB PAGE LAYOUT  
 
 

 
 
 
1. Legend Frame 
2. Map Frame 
3. Search Frame 
4. Tool Buttons 
5. Data Frame 
6. Geo-Spatial Positioning 
7. Data Box 
8. Map Size 

1. LEGEND 

2. MAP 

4. TOOL BUTTONS 

5. DATA AREA 

3. SEARCH 
AREA 

8. MAP 7. DATA 6. MAP POSITION 
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1. LEGEND  
 
 
 

 
 
 
 

• Scroll-able    
• Scale Dependent  

• Reference Data Layer Scales at: 
http://www.maricopa.gov/Assessor/GIS/scales.aspx 

• Manage Data Layers by clicking Check Boxes 
• Some Layers appear as Tool Tip Information Only 
• Data displays on map 
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2. MAP 
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16015 N 45TH ST
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4401 E LE MARCHE AVE
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16001 N 43RD ST
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15815 N 43RD ST
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16247 N 43RD ST

21523015F
16223 N 43RD ST
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3. SEARCH TOOLS  
 
3a. Search by APN 
 
 

 

 
 
• Fill in the APN (automatically tabs) 
• Click on Submit 
• Click on Zoom Selected to highlight parcel on map 
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4430 E LE MARCHE AVE

21529061
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4531 E LE MARCHE AVE

21529006
4518 E MARCONI AVE

21525004C
15848 N 44TH ST

21528008
15825 N 45TH ST
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3b. Search by Address 
 

 
 

 
 
• Fill in the Address Number ONLY (manual tab) 
• Fill in the Street Name ONLY 
• Click on Submit 
• Automatically locates Parcel and highlights it on map 
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4515 E BEVERLY LN

21525008
4303 E PARADISE LN
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21525003A
15821 N 43RD ST

21525004C
15848 N 44TH ST

21528008
15825 N 45TH ST
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3c. Search by Owner / Street   

 

 
 
• Fill in the Owner’s Last name ONLY (manual tab) 
• Fill in the Street Name ONLY 
• Click on Submit 
• Automatically locates Parcel and highlights it on map 
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21523015F
16223 N 43RD ST

21523015E
16224 N 44TH ST

21519369
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4515 E BEVERLY LN

21525008
303 E PARADISE LN

21529051
4407 E LE MARCHE AVE

21529048
4425 E LE MARCHE AVE

21529028
4513 E LE MARCHE AVE

21529083
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15825 N 45TH ST
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3d. Search by Multi-Owner, No Street 
 

 

 
 
• Fill in the Owner’s Last name ONLY (manual tab) 
• Click on Submit 
• Select APN from List 
• Automatically locates Parcel and highlights it on map 
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3327 W TANGERINE LN
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3306 W GOLDEN LN
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3451 W GOLDEN LN

15010147
3435 W GOLDEN LN
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8808 N 34TH AVE 15010158

8807 N 34TH AVE15010172
3443 W GOLDEN LN

15010170
3431 W GOLDEN LN

15010179
3422 W DEL MONICO LN

4B

15010199
3434 W TANGERINE LN

15010197
3437 W TANGERINE LN

15010220
3415 W TANGERINE LN
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3e. Search for APN by Subdivision Name 

 
 
• Fill in the Subdivision Name 
• Click on Submit 
• Scroll List for APN  
• Select APN 
• Automatically locates Parcel and highlights it on map 
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21238131
22307 N 39TH WY

21238129
3940 E CREST LN

21238130
22303 N 39TH WY
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3955 E CREST LN21238120

3943 E CREST LN38123
CREST LN

21238097

21238263

21238262

21238
22529 N 39

21238214
3958 E MORNING DOVE TR 21238222

3977 E SANDPIPER DR

21238261
21238209

3984 E MORNING DOVE TR

21238099
21238138

22420 N 39TH TER

21238135
22408 N 39TH TER

21240455
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21240460

21240463
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3959 E CREST LN

21238141
3967 E CREST LN

21238143
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3987 E CREST LN
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3995 E CREST LN
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3999 E CREST LN

21238151
22309 N 39TH RUN

21238152
22313 N 39TH RUN

21238153
22317 N 39TH RUN

21238154
22321 N 39TH RUN

21238155
22325 N 39TH RUN

21238156
22329 N 39TH RUN

21238157
22333 N 39TH RUN

21238159
3992 E HUMMINGBIRD LN

21238162
3980 E HUMMINGBIRD LN

21238164
3972 E HUMMINGBIRD LN

21238166
3964 E HUMMINGBIRD LN

21238168
22417 N 39TH TER

21238169
22413 N 39TH TER

21238170
22409 N 39TH TER

21238171
3958 E CREST LN

21238173
3966 E CREST LN

21238175
3974 E CREST LN

21238177
3982 E CREST LN

21238179
3990 E CREST LN

21238181
3993 E HUMMINGBIRD LN

21238183
3985 E HUMMINGBIRD LN

21238186
3973 E HUMMINGBIRD LN

21238190
22503 N 39TH TER

21238191
22507 N 39TH TER

0165

21240551

21238193
22515 N 39TH TER

21238195
3967 E MORNING DOVE TR

21238197
3975 E MORNING DOVE TR

21238199
3983 E MORNING DOVE TR

21238202
3995 E MORNING DOVE TR 21238204

22505 N 39TH RUN

21238205
22509 N 39TH RUN

21238206
22513 N 39TH RUN

21238266

21238268

21240316 21240319

0304

240306

21240309

21240311
2124040721240428

21240430 21240433

21240439

21240441

21240444

21240447

21240449
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3f. Search for Subdivision by MCR 

 

 
• Fill in the MCR Number (Select Sheet 1) 
• Click on Submit 
• Click on Zoom Selected 
• Automatically locates Subdivision and Zooms to it on the map 
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3g. Search for Subdivision by MCR - View Recorded Plat 

 
 

 
• Click on MCR Number 
• Opens MC Recorder’s Web Page 
• Click on Sheet to View 
• Opens MC Recorder’s Plat (See next page)
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Search for Subdivision by MCR - View Recorded Plat (Con’t) 

 
 
 
 
 
 
 
 
 
New Search 
• Click on New Search Button 
• Clears Parcel Data and returns Search Tools 
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3h. Search by Intersection 

 

 
 
 
 
 
 
 
• Click on Search by Street Intersection Link 
• Type in Road Names and Select Road Types 
• Click on Process 
• Zoom to Intersection on Map 
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21511002E

21518470
17245 N 47TH ST21518494

17243 N 46TH PL

21519386
4727 E BELL RD  39

21519114
16451 N 47TH ST 21519123

16451 N 47TH PL

21532083A
4901 E KELTON LN  1204

21532062A
4901 E KELTON LN  122521532112A

4901 E KELTO N LN  108221532130
4901 E KELTON LN  1055 21532087A

4901 E KELTON LN

21532597
16626 N 49TH W

21532175
4901 E KELTON LN  1035

21518472
17237 N 47TH ST

21519155
E AIRE LIBRE AVE

21519153
4651 E AIRE LIBRE AVE

21532675

21518474
17229 N 47TH ST

21518001B
4722 E BELL RD

21519387
4727 E BELL RD  37

21519113
16457 N 47TH ST

21532048A
4901 E KELTON LN  123921532069A

4901 E KELTO N LN  1218

21519121
16460 N 47TH PL

21519379
7 E BELL RD

21519383
4717 E BELL RD

21519384
4747 E BELL RD

21519382
4707 E BELL RD

21511985
4842 E BELL RD

21518500
17219 N 46TH PL

21518521

21518477
17217 N 47TH ST

21519381
4701 E BELL RD

21519385A

2153267621532009A
4901 E KELTON LN  2023

21532115D
16809 N 49TH ST

21532600
16702 N 49TH W21532013A

4901 E KELTON LN  126621532116
4901 E KELTON LN  1001

21532019A
4901 E KELTO N LN

21532017A
4901 E KELTON LN  1262

21532036A
4901 E KELTON LN  1251

21511198
4922 E BELL RD

21511212B

21511988B
4944 E BELL RD

21511987
17031 N TATUM BLVD

21518483
17210 N 47TH ST

21532490
16801 N TATUM BLVD

21532620
16934 N 49TH WY

21532123
4901 E KELTON LN  1008

21532599
16634 N 49TH WY

21532155
4901 E KELTO N LN  1015

21511194A
4808 E BELL RD 21511986

4830 E BELL RD

21511724A

21518479
17209 N 47TH ST

21532619
16930 N 49TH WY

21532493
16851 N TATUM BLVD

21532616
16842 N 49TH WY

21518481
17201 N 47TH ST

21532610
16818 N 49TH WY

21532491
16649 N TATUM BLVD

21532683

21532606
16803 N 49TH W

21518002A
4748 E BELL RD

215326
4949 E PHE

21532492
16635 N TATUM BLVD

21511723
17030 N 49TH ST

21532684

21532113D
16801 N 49TH ST

21532613
16830 N 49TH WY

21511197
4854 E BELL RD

21532113F
5139 E BELL RD

21532686

21532113E
4921 E BELL RD

21532115E

21518001C
4750 E BELL RD

21532623
16946 N 49TH W

21532181
4901 E KELTON LN  1029 21532025A

4901 E KELTON LN  1073 21532043A
4901 E KELTO N LN  1243

21511988A
4940 E BELL RD

21532161
4901 E KELTO N LN  1023
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PROPERTY INFORMATION – Data Tabs 

 

 
• Search or Select Parcel from Map 
• Select One of Three Tabs 
• Links to MC Recorder’s Page, Legal Definition, Improvement Quality Grade Definition 
• Can Print Property Data in Page Format – Click Print Button (See next page) 
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PROPERTY INFORMATION – Data Tabs (Con’t) 
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PROPERTY INFORMATION (Con’t) – View Similar Parcels 
 

 
 
• Search or Select Parcel from Map 
• Click View Similar Parcels Button 
• Opens Similar Parcels Page (See next page) 
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PROPERTY INFORMATION – View Similar Parcels (Con’t) 
 
 

 
 
• Lists Subject Parcel 
• Lists Similar Parcels 
• Links to open Similar Parcel Data 
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PROPERTY INFORMATION – View Tax Bill 
 

 
• Search or Select Parcel from Map 
• Click View Tax Bill Button 
• Opens MC Treasure’s page 
• Scrollable 
• Select Treasurer’s Category for additional Tax Information
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                                                         TOOL BUTTONS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 

Train_Handout_07.doc              26            

 
4. TOOL BUTTONS  

 

 
  

Select / Clear - 

 
• Select individual parcel  
• Select multiple parcels - Hold Shift and Select with Cursor 
• Select multiple parcels - Click and Hold Left Mouse Button and Drag a Box 
• Clears – Clears All selected parcels 
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4a. Zoom-In / Zoom-Out / Zoom Previous / Zoom All 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

• ZOOM – IN and ZOOM – OUT at pre-set scales with single mouse clicks 
• Click and Hold Left Mouse Button and Drag a Box 
• ZOOM Previous zooms to the previous views sequentially 
• ZOOM ALL is full county view 
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4b. Zoom-GoTo 

 
 

 
 
 
 
 
 

• Pick a CATEGORY from Drop Down List 
• Type in Location appropriate for the Category 
• Zoom To Width: Caution  

• Feet  -  use 500’ – 1,000’  
• Miles  -  use .01 or .02 

• Click OK 
• Zooms to Feature or Area 
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4c. Pan 

 
 

 
 
 
 
 
• Left Click and Hold Mouse button in Map Area 
• Drag Map in any direction 
• Works at any scale 
• For better performance, turn off large data layers in Legend 

 

+ 

+ 
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4d. Buffer / Remove Buffer 
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t

4
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4
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Monte Cristo Ave
Monte Cristo Ave

Beverly Ln

21529009
15826 N 45TH PL

25003B
N 43RD ST

21525004B
15838 N 44TH ST 21528065

4415 E MARCONI AVE
21529012

4519 E MARCONI AVE
21528009

15815 N 45TH ST

21519289
4517 E SANDRA TERRACE

21519357
4425 E PARADISE LN

21519359
4439 E PARADISE LN

21519354
4401 E PARADISE LN

21519293
4516 E BEVERLY LN

21519361
4509 E PARADISE LN

23015F
N 43RD ST

21523015E
16224 N 44TH ST

21519295
4534 E BEVERLY21519369

4402 E BEVERLY LN
21519366

4424 E BEVERLY LN

21519332
4517 E BEVERLY LN

21519364
4442 E BEVERLY LN21519370

4425 E BEVERLY LN

21519362
4517 E PARADISE LN

21519376
4515 E BEVERLY LN

21519
4535 E BEVE

525008
ARADISE LN

21529051
4407 E LE MARCHE AVE

21529048
4425 E LE MARCHE AVE

21529028
4513 E LE MARCHE AVE

21529083
4530 E MONTE CRISTO AVE21529086

4512 E MONTE CRISTO AVE

21529041
4402 E MONTE CRISTO AVE

21529046
4430 E MONTE CRISTO AVE25002A

N 43RD ST
21525006

16010 N 44TH ST

21529033
16001 N 45TH ST21529035

4431 E MONTE CRISTO AVE

525013
N 43RD ST

21525005A
16002 N 44TH ST 21529039

4407 E MONTE CRISTO AVE

21528003
4402 E MARCONI AVE

21528006
4436 E MARCONI AVE

21529088
4517 E MONTE CRISTO AVE

21529091
4535 E MONTE CRISTO AVE

21529008
15830 N 45TH PL

21528007
15835 N 45TH ST

21519371
4433 E BEVERLY LN 21519375

4509 E BEVERLY LN
21519373

4447 E BEVERLY LN 21519377
4531 E PARADISE LN

21519335
4536 E PARADISE LN

23014B
ARADISE LN

21523014D
4340 E PARADISE LN

21519001E
4411 E BEVERLY LN

21529055
4414 E LE MARCHE AVE

21529058
4430 E LE MARCHE AVE

21529061
4508 E LE MARCHE AVE 21529064

4526 E LE MARCHE AVE

21525001P
4325 E PARADISE LN

21529021
16039 N 45TH

21529065
16032 N 45TH PL 2152902

16033 N 45T

21529023
16027 N 45TH21529025B

4531 E LE MARCHE AVE

21529006
4518 E MARCONI AVE

21529004
4526 E MARCON

25003A
N 43RD ST

21525004C
15848 N 44TH ST

21528008
15825 N 45TH ST

Click Buffer Button…. 
Enter buffer distance… 
Click OK 

Select parcel or 
multiple parcels 
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• Zoom into Map Area  
• Select Parcel or Multiple Parcels 
• Click Buffer button 
• Buffer Distance Dialog Box opens 
• Type in Distance – 50’ – 1,000’ returns best results 
• Click OK 
• Automatically creates Buffer and Selects parcels 
• Creates a Parcel List and Count in upper right Data Area 
• Parcel Selection Count 
• See Create Mailing Lists and Labels Chapter to print mailing list and labels 

 
 
 
 
 
 

4e. Measure 

 
 
 

• Linear measurements Only 
• Does Not calculate square footage 
• Click Left Mouse button and move Cursor 
• Click Left Mouse button again to change direction 
• Double Click Left Mouse button to remove Measure Cursor 
• Display:  

• Top – single distance 
• Bottom – aggregate distance 
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4f. Copy to Clip Board 

 
• Captures image of map  
• Can paste to other applications such as Word, PhotoShop, etc. 
• Perform EDIT – PASTE function or CONTROL-V key function 
• Can drop image into message of an E-mail
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4g. Copy URL 

 
• Captures URL 
• Can drop URL into message of an E-mail 
• Recipient Clicks on URL and Opens same map 
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4h. Print Set-Up / Print Map – (see attached print map samples) 

 

 
 
• Choose your options 
• Type in Title if desired 
• Check Fit to Page 
• Click on Print Setup 

 
 

 
 
• Choose your printer options 
• Check Landscape 
• Go to printer properties, set any necessary properties 
 

4i. Stop –Stops running current process 
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4j. Help – MapGuide QUICK VIEWING TIPS 

 
RIGHT MOUSE CLICK MENU - (right mouse click anywhere on the map) 
PAN – Move right, left, up and down on the map. 
RELOAD - Reload the current map to refresh the features. 
PRINT -  
Page Setup - To set your page and printing parameters. The user can choose to include a legend and 
type in a map title 
Print - To print the current map. 
COPY -  
Copies to clipboard - copy the current map to the clipboard. This can be pasted into other applications 
such as word processors or spreadsheets. 
As URL – This will copy the current map URL. 
ZOOM -  
Zoom - Zoom In by selecting a window box or picking a point. 
GoTo - Zoom to a designated feature. First select a category- for example, Parks. Then type in the 
location using all caps - for example, ENCANTO. If the feature is a point feature, you can specify how 
much of the map you want to see in the "zoom to width" box 
Width – Zoom to a specified width. For example, 5 miles. 
Scale – Zoom to a specified scale. For example, 1:50,000 
Selected – Zoom to a feature that the user has selected. 
Previous – Zoom to the previous view 
Out – Zoom out 
Unzoom – Zoom to the full extents of the map 
BOOKMARKS -  
Add a bookmark – Add a bookmark to the current map extents for easy reference. 
Delete a bookmark – Delete a currently established bookmark 
SELECT -  
Select Parcel 
Map Objects – Select object in the currently displayed view from a list. First select the desired map layer, 
and then select the desired object. 
Radius – Selects all objects that are completely within a user drawn circle radius. 
Polygon – Selects all objects that are completely within a user drawn polygon. 
Within – Select all objects that are within selected polygon objects. For example, select all parcels that 
are within a specified subdivision boundary. Select the subdivision first, then using the select within, 
choose the parcels layer from the list. 
Clear – Clears all selected features 
VIEW -  
Report – View reports for the selected objects. (None currently available.) 
Buffer – To construct a buffer with a specified distance around a selected feature. The user can set the 
line type and shading options. To clear the buffer, turn the buffer layer off in the legend. 
Remove Buffer 
Distance – To measure distances on the map in feet and miles. 
View Approximate land size- after a parcel is selected, this button will calculate the approximate land size 
in square feet and acres. 
HELP -  
Stop- If the map is taking too long to load because the process hangs, you can stop the process. This 
button is also used if you do not want to wait for all of the features to load before you zoom again. 
Preferences – Brings up the established map preferences 
Contents – Brings up the AutoDesk MapGuide Viewer Help Documentation 
Help- Displays up the MapGuide Quick Viewing Tips. 
About Map Guide – Brings up information on the current version of MapGuide.  
** To create mailing labels from a list of parcels, see our help on how to do a mail merge. 
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4k. Zoom to Scale 
 

 
 

 
• Zoom into general Map Area 
• Right Click Mouse Button 
• Cursor over Zoom, then Scale, Left Click on Scale 
• Opens Zoom Scale Dialog Box  
• Type in Scale, Click OK 
• Zooms In to Scale 
• Reference Data Layer Scales at: http://www.maricopa.gov/Assessor/GIS/scales.aspx 
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4l. Additional Tools 
i. Bookmarks – Add Bookmark 

 

 

 
• Zoom into Parcel or Map Area to Bookmark 
• In Map Area, Right Click Mouse Button 
• Cursor over Bookmark, then Add Bookmark and Left Click 
• Opens Add Bookmark Dialog Box  
• Type in Your Title, Click OK 
• Captures Map Area 
• Can create many Bookmarks 
• Bookmarks are saved to individual PC registry 
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ii. Bookmarks – Select Bookmark 

 

 
• In Map Area, Right Click Mouse Button 
• Cursor over Bookmark, then over your Title and Left Click 
• Opens Map to your Bookmark
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iii. Bookmarks – Delete Bookmark 

 

 
 

 
• In Map Area, Right Click Mouse Button 
• Cursor over Bookmark, then Delete Bookmarks and Left Click 
• Opens Delete Bookmark Dialog Box  
• Scroll through list, select Bookmark to Delete, Click OK 
• Bookmark is Deleted 
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iv. Select Parcels by Radius 
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Select Parcels by Radius (Con’t) 

 
• Zoom into Map Area to Select Parcels  
• In Map Area, Right Click Mouse Button 
• Cursor over Select, then Radius and Left Click 
• Cursor changes to the Radius Tool 
• Click and Hold Left Mouse Button, Drag a radius to desired size 
• Release Button 
• All Parcels Completely or Partially within the radius is selected 
• A Parcel List is created in Data Area 
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v. Select Parcels by Polygon 
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Select Parcels by Polygon (Con’t) 
 

 
• Zoom into Map Area to Select Parcels  
• In Map Area, Right Click Mouse Button 
• Cursor over Select, then Polygon and Left Click 
• Cursor changes to the Drawing Tool 
• Click and Release Left Mouse Button, Drag a line through the parcels you want to 

select 
• Click once each time you want to create a vertices and change direction 
• Continue until line is close to beginning vertices 
• Double Click to close polygon 
• All Parcels within polygon line are selected 
• A Parcel List is created in Data Area 
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vi. Tool Tips – Cursor-Over Information – (Zoning example) 

 

 
 

• County wide Zoning used as this example 
• Zoom into Map Area to Select Parcels  
• Scroll Down Legend to County wide Zoning, Check on Box 
• Place Cursor over the parcel or Area, hold Cursor still 
• Tool Tip appears 
• Check off Box when finished 
• Many layers use Tool Tips 
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vii. Map IDs 

 

 
• To Order Paper Maps 
• Zoom into Map Area  
• Scroll Down Legend to Assessor’s Features, Check on Map ID #s Box 
• Place Cursor over the parcel or Area, hold Cursor still 
• Tool Tip appears with Map ID Number 
• Contact Assessor’s Office to order Map 

• Maps can be printed on paper 
• Maps are available digitally as a HPG or Adobe PDF file 

• Check off Box when finished 
• See next page for sample (Map ID – 780180304) 
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Map IDs (Con’t) 
 
Map ID – 780180304 
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viii. Setting Map Preferences 

 

 

 
• Right Click Mouse Button 
• Cursor over Help, then Preferences, Left Click Mouse button 
• Opens Preferences Dialog Box  
• Choose USA or Metric Units (USA Default) 
• Check Display mouse position, Choose Latitude-Longitude or Mapping Coordinate 

System (NAD 83 AZ State Plain-Central Feet Default) 
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ix. SCREEN CAPTURE – PRINTING FROM MS WORD – Copy Function 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Open a MS Word session 
• Set up page with multiple Returns or create page template (See Page 54) to accept 

images 
• Minimize MS Word 
• Open Assessor’s GIS Web page and zoom to area and scale desired 
• Check on appropriate Layers in Legend 
• Click the Copy to Clipboard Tool Button 

• Restore MS Word and Place Cursor on page where you want to insert Map 
• Perform EDIT – PASTE function or CONTROL-V key function 
• Type in text, add graphics, etc 
• Save document 
• Print or E-mail document 
• This method can be used to paste maps into other applications 
• To Remove image, Click on image and Tap Delete function key 
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4426 E MARC

21525003A
15821 N 43RD ST

21525004C
15848 N 44TH ST

21524038
15827 N 41ST PL
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x. SCREEN CAPTURE – PRINTING FROM MS WORD – Print Screen Function to 
Capture Tool Tips 

 

 
• Open a MS Word session 
• Set up page with multiple Returns or create page template to accept images 
• Minimize MS Word 
• Open Assessor’s GIS Web page and zoom to area and scale desired 
• Check on appropriate Layers in Legend 
• Place and Hold Cursor in Map Area for Tool Tip 
• Tap the Print Screen/SysRq function key on Keyboard 
• Restore MS Word and Place Cursor on page where you want to insert Map 
• Perform EDIT – PASTE menu function or CONTROL-V key function 
• Captures entire PC screen 
• Type in text, add graphics, etc 
• Save document 
• Print or E-mail document 
• This method can be used to paste maps into other applications 
• To Remove image, Click on image and Tap Delete function key 
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xi. SCREEN CAPTURE – PRINTING FROM MS WORD – Crop Images 

 
• Open a MS Word session 
• Set up page with multiple Returns or create page template to accept images 
• Open View-Toolbars-Picture Tool Bar in Word 
• Minimize MS Word 
• Open Assessor’s GIS Web page and zoom to area and scale desired 
• Check on appropriate Layers in Legend 
• Place and Hold Cursor in Map Area for Tool Tip 
• Tap the Print Screen/SysRq function key on Keyboard 
• Restore MS Word and Place Cursor on page where you want to insert Map 
• Perform EDIT – PASTE menu function or CONTROL-V key function 
• Captures entire PC screen 
• Type in text, add graphics, etc 
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SCREEN CAPTURE – PRINTING FROM MS WORD – Crop Images (Con’t) 

 
 
 
 
 
 
 
 

• Place Cursor on Image to Crop and Click Left Mouse button once 
• Select Crop Tool from Picture Tool Bar 
• Place Crop Tool Cursor on image Handlebar, Click and Hold Left Mouse button, and 

drag Handlebar to Crop image 
• Click on page outside of the image to clear Crop Tool 
• Click on image again and use Cursor to re-position image 
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xii. SCREEN CAPTURE – PRINTING FROM MS WORD – Adding Labels and Arrows to 
Images 

 

 
• Open a MS Word session 
• Set up page with multiple Returns or create page template to accept images 
• Open View-Toolbars-Drawing Tool Bar in Word 
• Minimize MS Word 
• Open Assessor’s GIS Web page and zoom to area and scale desired 
• Check on appropriate Layers in Legend 
• Place and Hold Cursor in Map Area for Tool Tip 
• Tap the Print Screen/SysRq function key on Keyboard 
• Restore MS Word and Place Cursor on page where you want to insert Map 
• Perform EDIT – PASTE menu function or CONTROL-V key function 
• Captures entire PC screen 
• Type in text, add graphics, etc 
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SCREEN CAPTURE – PRINTING FROM MS WORD – Adding Labels and Arrows to Images 
(Con’t) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Position image on page 
• Select Text Box Tool from Drawing Toolbar 
• Place Text Box Cursor on image, Click and Hold Left Mouse button, and drag to size 

a text box 
• Type label in Text Box 
• Adjust Size, Font, Color, etc 
• Re-size Text Box 
• Reposition Text Box if necessary – Click and Hold Cursor on Text Box boarder, Drag 

to position 
• Add Arrows – Use Arrow Tool from Drawing Toolbar 

• Place Cursor on edge of Text Box, Click, Hold, and Drag Cursor to parcel 
• Release Cursor 
• Adjust Size, Color  
• Reposition if necessary 
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xiii. SAMPLE MS WORD TEMPLATE for DATA PRINTING 

 
 
 
 
 
 
 Report: 
 This parcel is located at 4431 E. Le Marche in Phoenix.  
 APN Num. 21529047 
 Status: Residential, no pool. Occupied 
 

 

ABC Company 
123 Main Street 
Phoenix, AZ 85000 
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                                                                                                      DATA 
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5. DATA - CREATE MAILING LABELS using a MAIL MERGE 
 

 

 
 

 
CREATE A TEXT FILE OF THE SELECTED PARCELS: 
 
Using the Interactive Maps: 

 
• Select the desired parcels 

 Search for a parcel 
 Zoom to the parcel 
 Make sure the parcel is selected (Use select tool or click the ‘Highlight Parcel’ button) 
 Click on the ‘Parcel Buffer’ button 
 In the dialog box enter the buffer distance in feet and click OK 
 OR you can simply use the selection tool to draw a box around the desired parcels. 

 

• Results will post in the upper right frame of the screen 
• Click on the ‘semi-colon delimited’ button 
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• Save the results as a text file 

 When the report appears on the screen under the ‘Edit’ menu, choose ‘Select All’ (Ctrl 
+A) 

 Under the ‘Edit’ menu, choose ‘Copy’ (Ctrl +C) 
 Open Microsoft Notepad (Start  All Programs  Accessories  Notepad), or a similar 

text editing application 
 Paste the results into Notepad using the ‘Paste’ (Ctrl +V) command under the ‘Edit’ 

menu 
 Under the ‘File’ menu, choose the ‘Save’ (Ctrl +S) command 
 Use ‘mailinglist.txt’ as the File name 
 Make sure that the ‘Save as type:’ is set to Text Documents (*.txt) 
 Click ‘Save’ 
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CREATE THE MAIL MERGE USING THE TEXT FILE: 
 

The following are quick instructions for performing a Mail Merge to create mailing labels using 
Microsoft Word 2003.  Specific assistance can be found by searching help in your Office 
productivity software for Mail Merge and Mailing labels. 

 
 
Using Microsoft Word 2003: 
 

• Create a new blank document 
• Under the ‘Tools’ menu, select ‘Letters and Mailings’ and then ‘Mail Merge’ 
• Select labels as the document type (Step 1 of 6) 
• Select your specific label type from the ‘Labels options’ window (Step 2 of 6) 
• Browse for the ‘mailinglist.txt’ file that was created from the CREATE A TEXT FILE 

OF THE SELCTED PARCELS instructions above.  A window showing the ‘Mail Merge 
Recipients’ will appear.  Make any edits to the records and then click the ‘OK’ button 
to close the window (Step 3 of 6) 

• Click the ‘Address Block’ label to add the address to the label.  Click ‘OK’ to close 
the ‘Insert Address Block’ window.  The software should arrange the data from the 
NAME, ADDRESS, CITY, STATE, ZIP, and COUNTRY fields into the address block.  If 
you wish to include the parcel number on the label, click the ‘More items’ label and 
select PARCEL from the available database fields.  Click on the ‘Update all labels’ 
button to populate the remaining labels on the page (Step 4 of 6) 

• Preview the labels and make any changes to the appearance (Step 5 of 6) 
• Complete the merge and print the labels (Step 6 of 6). 
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                                                          MAP POSITION 
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6. GEO-SPATIAL POSITIONING (Map Position) 
 
 

 
 
 
Displays the map positioning of the selected parcel(s).
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                                                                                              DATA BOX 
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7. DATA BOX 
 

 
 
 
Displays the number of parcels selected. 
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                                                     MAP AREA
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8. MAP AREA (SIZE) 
 

 
 
 
Displays the map area. 
 
 


